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YASARA チュートリアル 

タンパク－リガンド・ドッキング計算 
 

（株）アフィニティサイエンス 
 

 

概要：YASARA Structure(Version 24.4.10)によるタンパク‐リガンドのドッキング操作（ある標的タンパクを対象と
した単一リガンド、または複数リガンドのドッキング計算）をチュートリアル形式で説明します。 

（一部旧 ver.で撮影したスクリーンショット画像が含まれています。） 

 

1. はじめに 

 本チュートリアルでは、次の 2 通りのドッキング手法について解説します。 

 

❑ 単一リガンドを用いた基本的な低分子ドッキング（ドッキング基礎 p.1~） 

❑ 複数リガンドを用いたドッキングスクリーニング（ドッキング応用 p. 12~） 

 

 それぞれ独立しているので、どちらからも開始することが可能ですが、ドッキング基礎から進めることを推奨します。な

お、複数のレセプター構造を対象とするアンサンブルドッキング、レセプター側鎖の自由度を考慮したフレキシブルドッキ

ングについては割愛させていただきます。 

 本チュートリアルの末尾には、ヘルプ情報やドッキング関連の付属マクロファイルなど、補足となる情報を記載していま

すので、必要に応じてご参照ください。 

 

 

2. ドッキング基礎 

単一リガンドと単一レセプターを用いた基本的なタンパク-リガンド・ドッキングの操作方法を説明します。この項目で

は例として、アルツハイマー病の発症に関与すると考えられるアミロイドβタンパクの産生および凝集性を決定する酵素

β-site APP cleaving enzyme 1（BACE1）の複合体構造（PDB ID:5I3V）を用いて、リガンドの再ドッキングを行います。 

※本チュートリアルではリガンドの再ドッキングを行いますが、他のリガンド分子を用いた通常のドッキングも、レセプタ

ーとリガンドの構造ファイル（~_receptor.拡張子、~ligand.拡張子）を用意すれば同様の操作で実行できます。 

 

2.1 ドッキング準備 

2.1.1 作業ディレクトリの作成と YASARA（GUI）の起動 

ドッキングを実施するにあたり入出力ファイルを格納するディレクトリ（フォルダ）を新規に作成します（Windows で

はエクスプローラ、Linux では mkdir コマンド等を使用）。作成場所やファイル名は任意で問題ありませんが、YASARA 上

で表示が乱れるため、日本語を含まない方が好ましいです。 

 

例 

(Windows) C:¥Users¥username¥Desktop¥YASARA_DATA¥tuto_docking 

(Linux)  /home/username/YASARA_DATA/tuto_docking 

 

 その後，YASARA（GUI）を起動します。 

「Options」→「Working directory」を選択し、先ほど作成したディレクトリを指定し作業ディレクトリを設定します。 
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※ここで設定した作業ディレクトリは YASARA 内部でカレントディレクトリとして扱われ、パス等別途追加設定しない限

り、入出力ファイル等はこちらに格納されます。 

  

2.1.2 PDB ダウンロードと構造可視化・確認 

「File」→「Load」→「PDB file from Internet」を選択し、「5i3v」を入力、PDF ファイルをダウンロードすると、画面上

にタンパク 3D 構造が表示されます。 

※インターネット未接続の場合、PDB ファイルを別途入手し、「File」→「Load」→「PDB file」等から構造を読み込んで

ください。 

「View」→「Style scene」またはファンクションキーで分子の表示方法を変えることができます。本チュートリアルでは、

「Ribbon」（F6 キー）に設定しています。 

 

 

Figure 2.1  PDB ファイルのダウンロード 

 

2.1.3 ドッキング前処理①（クリーニング・不要分子削除） 

クリーニング処理 

 解析のため、「Edit」→「Clean」→「All」を選択して、PDB 構造のクリーニング処理（欠損原子・水素付加、結合次数の

調整など）を行います。 

 

Figure 2.2 Clean 処理による水素分子（白球）の付加 

 

不要分子の削除 

続けて、レセプター（タンパク）とリガンド（低分子）以外の不要なものを取り除くため、メニュー「Edit」→「Delete」

→「Molecule」を実行して、水分子（Waters）および不要分子を削除します（今回は、上から 1 番目がタンパク分子、3 番

目がリガンド分子なので、その他の分子を Ctrl キーを押しながら複数選択して削除してください。 
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Figure 2.3 Delete の実行（Ctrl キー＋クリックで複数選択が可能） 

 

 

 

2.1.4 ドッキング前処理②（分子名変更・オブジェクト分割・ドッキングセル設定） 

分子名変更 

画面右側 HUD の Molecule 名(“Mol”に続く部分)がデフォルトではすべて“A”になっているため、それぞれの Molecule を

右クリックして「Name」を選択し、適当なものに変更します。本チュートリアルではレセプター（一つ目の Mol A）に

“R”、リガンド（二つ目の Mol A）に“L”と設定しました。名前はアルファベット 4 文字以内で変更可能です（大文字・小

文字別）。 

※この操作は必須ではありませんが、作業中に混乱しないために実行しておくことをおすすめします。 

 

  

Figure 2.4 Molecule 名の変更 

 

オブジェクト分割 

この段階では同じ Object の中にレセプターとリガンドが含まれている状態のため、別々の Object に分割します。 

画面右側 HUD の Object（5i3v）を右クリックして、「Split」を選択、Center の設定は好みのほうを選択し、「Split at all 

molecules」をクリックします。 （本チュートリアルでは、分割後の Objects が同じ（ローカル）座標系を持つ「Do not 

Center ~」を選択します。もう一方の「Center the newly created objects ～」を選択すると、幾何中心がそれぞれのローカル

座標の原点と一致するように新規オブジェクトがシフトされます。） 

【Tips】クリーニング処理について 

クリーニング処理（Clean コマンド）の処理内容の詳細は、ユーザーマニュアルの以下のページを参照してくださ

い。 

Commands - Tell YASARA what to do ＞ Edit - Change content and properties of the soup ＞ Building - Build atoms to 

molecules, oligomers, crystals, loops and genomes ＞ Clean<Obj|All> - Clean objects for molecular dynamics simulation 

また、YASARA Dynamics 以上のグレードでは、Clean 処理に続けて、Edit > Add > hydrogens to: Object & optimize

から水素結合ネットワークの最適化を行うことも可能です。詳しくは、ユーザーマニュアルの OptHyd<Obj|All>コ

マンドの説明を参照してください。 
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Figure 2.5 Split 処理による Object の分割 

 

ドッキングセル設定 

結合ポケット付近にドッキング範囲を指定します。画面右側 HUD のリガンド Object（5i3vL）を右クリックし、「Select」

→「newly」を選択することでリガンドを選択状態にします。次に「Simulation」→「Define simulation cell」を選択、「around 

selected atoms」をクリックすることでリガンド周辺にドッキング範囲(SimCELL)が出現します。 

※デフォルト設定では、Cube 形状でリガンドから 5Åの距離に SimCELL が設定されます。SimCELL の設定を省略する

場合、タンパク全体を対象としたドッキングが実施されます。詳しくは、ユーザーマニュアルの Cell コマンドの説明を

参照してください。 

 

 

Figure 2.6 SimCELL の定義 

 

2.1.5 ドッキング前処理③（リガンド・レセプター構造ファイルの保存） 

 マクロファイルを利用してドッキングを実行する場合は、構造ファイルを作業ディレクトリに保存します。 

（ドッキングを『2.2.1 [方法①]簡易手法（GUI）』で実行する場合は、この手順をスキップして手順『2.2.1 [方法①]簡易手法

（GUI）』へ進んでください。） 

リガンドファイルの保存 

リガンドのみのファイルを pdb、yob、sdf、mol2 形式のいずれかで作業ディレクトリ内に保存します。本チュートリア

ルでは.yob 形式で保存します。「File」→「Save as」から「YASARA Object」を選択し、リガンド Object（5i3vL）を指定し

て保存します。ファイル名は必ず「(任意の文字列)_ligand(.拡張子)」としてください（例 5i3v_ligand.yob）。 

レセプターファイルの保存 

次に、レセプターのみのファイルを作業ディレクトリ内に保存します。pdb、yob、sce のいずれの形式でも構いません

が、結合ポケットを指定する場合は、SimCELL の情報も一緒に保存可能な sce 形式を選択する必要があります。本チュ

ートリアルでは SimCELL を設定しているので.sce 形式で保存します。画面右側 HUD でリガンド Object（5i3vL）を右ク

リックし、「Delete」を実行して削除、レセプターと SimCELL のみを残します。 

（この時、画面右側 HUD の削除した Object の空欄が気になる場合は、「Edit」→「Number」→「Object from 1」を選択す

るとオブジェクト番号を振りなおすことができます。） 

続いて、「File」→「Save as」から「YASARA Scene」を選択、ファイル名は必ず「(任意の文字列)_receptor(.拡張子)」とし

ます。(任意の文字列)部分にはリガンドファイルと共通の文字列を使用します（例 5i3v_receptor.sce）。 
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2.2 ドッキング実行 

YASARA でドッキングを行うには、GUI から直接ドッキング解析・条件設定を行う簡易的な方法（①）と、マクロを用

いて実行する方法（②、③）の 2 つの手段があります。ドッキング結果の解析機能等の観点から、後者のマクロ利用が推

奨されていますが、ここでは各方法について紹介します。 

 

2.2.1 [方法①]簡易手法（GUI） 

力場設定 

GUI からドッキングを実行するには力場の設定が必要になります。「Simulation」→「Force field」を選択し、力場を選択

して、「OK, and if ~ parameters」をクリックします。（本チュートリアルでは AMBER03 を選択） 

 

Figure 2.7 力場設定 

 

ドッキング Experiment 実行 

「Options」→「Choose experiment」→「Docking ligand to receptor」を選択し、「Proceed with experiment」をクリックしま

す。まずレセプターを指定（5i3vR）、次にリガンドを指定（5i3vL）、そしてドッキングプログラム（VINA）、条件（例 Docking 

runs = 25, Cluster RMSD = 5.00A）、出力ファイル名（初期値は YourComplex001、前半の文字列は任意、末尾は 001 のよう

な数値とします。）を指定して「OK」をクリックするとドッキングプロセスが開始します。 

計算が終了すると操作画面に結果が表示されます。続きは手順『2.3.1 計算終了時の画面』をご覧ください。 

 

 

Figure 2.8 ドッキングシミュレーションパラメータ設定画面 

 

【Tips】力場選択ダイアログ 

力場の設定画面では、「OK, and if ~ parameters」または「Set these ~ instead:」を選択します。前者を選択すると、

Cutoff(カットオフ値)、Longrange(長距離静電相互作用の扱い)、Boundary(シミュレーションセルの境界設定)のパ

ラメータが、それぞれの力場に適したものに自動で設定されます。パラメータを自身で指定したい場合は、画面

下方のパラメータを調整し、後者を選択してください。 
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2.2.2 [方法②]マクロファイルを利用する方法（GUI） 

ドッキング計算の実行に当たっては、パラメータやコマンドが記述されたマクロファイルを読み込んで自動的に実行

する方法も存在し、現行版ではこちらを使用することが推奨されています。マクロを利用する場合、リガンドとレセプタ

ーそれぞれの構造ファイルを準備する必要があります。以下ではソフトウェア付属のドッキング計算用マクロファイル

を利用する流れを紹介します。 

ドッキング関連の付属マクロファイルの種類については、補足の「4.2 ドッキング関連の付属マクロファイル」をご参照

ください。 

 

ターゲット（MacroTarget）設定 

「Options」→「Macro&Movie」→「Set target」で、マクロを適用するために MacroTarget を設定します。 

作業ディレクトリを選択し、レセプターとリガンドのファイル名に使用した共通の (任意の文字列)部分をターゲット名

として設定します（本チュートリアルでは「5i3v」）。例えば、表示されるダイアログから作業ディレクトリを選択後、先

ほど作成したリガンドまたはレセプターファイルのどちらかを選択し、右側の Remove…「from underscore」にチェックを

入れてアンダースコア（_）以下を除外します。もしくは「Filename」に直接(任意の文字列)を入力してもよいです。これ

により、 ここで指定した値が変数 MacroTarget に格納され、マクロ実行時に入出力用ファイル名の共通の接頭辞として

利用されます。 

 

 

Figure 2.9 マクロターゲットの設定例 

 

 

 

ドッキング実行 

「Options」→「Macro&Movie」→「Play macro」でドッキングを実行します。「dock_run.mcr」または「dock_runensemble.mcr」

を選択します。前者では単一のレセプターのみでドッキングを行い、後者では側鎖の回転異性体(side-chain rotamers)を考

慮して数種のレセプターを自動で作成し、ドッキングを行います。本チュートリアルでは「dock_run.mcr」を使用します。 

【Tips】 マクロターゲット（MacroTarget）の指定について 

YASARA 付属の多くのマクロファイルは内部で MacroTarget という変数を利用しています。 

マクロファイルは、この変数から作業ディレクトリや入出力ファイルの情報を取得し、それぞれの処理を実行しま

す。このため、「（例）C:¥Users¥username¥Desktop¥YASARA_DATA¥tuto_docking¥5i3v」のようにフォルダ（絶対パス）

とファイル接頭辞を含めて指定したり、予め設定した作業ディレクトリ（カレントディレクトリ）内にマクロを適用

するファイルが保存してあれば、相対パスとして、ファイル接頭辞（例、上記の太字部分「5i3v」）のみを指定したり

することができます。後述のコマンドラインから実行する際も、絶対パス・相対パスのどちらでも指定が可能です。 

使用するマクロファイル：「dock_run.mcr」または「dock_runensemble.mcr」 

必要なファイル： ・リガンド構造ファイル 「(Macrotarget）_ligand(.拡張子)」（pdb、yob、sdf、mol2 形式） 

   ・レセプター構造ファイル「(Macrotarget）_receptor(.拡張子)」（pdb、yob、sce 形式） 
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Figure 2.10 ドッキングシミュレーションマクロ（dock_run.mcr）の実行結果 

 

2.2.3 [方法③]マクロファイルを利用する方法（CUI） 

コマンドラインからマクロファイルを使用しドッキングを実行する場合も [方法②]の手順と同様にレセプター・リガン

ドの両ファイルを準備します。次に Windows であればコマンドプロンプト（Win キー+R キーでファイル名を指定して実行

ダイアログを開き、名前に cmd を入力し OK ボタンをクリックすることで起動可）、Linux であればターミナルプログラム

（gnome-terminal など）を開き、次の手順に従いコマンドを入力、Enter キーを押すことで実行することができます。 

① YASARA インストールディレクトリ内の YASARA 実行ファイルを指定。 

スペースを空け、テキストモード用オプション（-txt）を指定。 

② スペースを空け、次に YASARA インストールディレクトリ内の mcr ディレクトリに格納されているマクロを指定。 

③ スペースを空け、最後に MacroTarget を指定。 

（全体をダブルクォーテーション（"）で囲み、ターゲットをシングルクォーテーション（'）で囲む）。 

※dock_run.mcr を適当なディレクトリにコピー・編集する事で MacroTarget や各種パラメータの設定も可能です。 

実行例（絶対パス使用） 

(Windows) C:¥Users¥username¥Desktop¥yasara¥YASARA.exe -txt C:¥Users¥username¥Desktop¥yasara¥mcr¥dock_run.mcr 

"MacroTarget='C:¥Users¥username¥Desktop¥YASARA_DATA¥tuto_dock¥5i3v'" 

(Linux)   /home/username/yasara/yasara -txt /home/username/yasara/mcr/dock_run.mcr  

"MacroTarget='/home/username/YASARA_DATA/tuto_md/5i3v'" 

実行例（環境変数 Path/Path および相対パス使用、マクロファイルを作業ディレクトリに保存してある場合） 

(Windows) YASARA.exe -txt dock_run.mcr "MacroTarget='5i3v'" 

(Linux)   yasara -txt dock_run.mcr "MacroTarget='5i3v'" 

 【Tips】マクロファイル「dock_run.mcr」のパラメータについて 

dock_run.mcr の標準ドッキングプログラムは、AutoDock VINA となっています。これを AutoDock に変更する場合、

マクロファイル内のパラメータ method の値を次のように変更します。 

 変更前    変更後 

 method=’VINA’   method=’AutoDockLGA’ 

同ファイルには、ドッキング試行回数：runs、クラスター分類のカットオフ値：rmsdmin、リガンド配座固定：rigid な

ど、ユーザー定義可能なパラメータが複数用意されており、必要に応じて適宜調整することができます。 

なお、ドッキングプログラムに AutoDockLGA を指定した場合は、GPU を利用することもできます（Ver. 23.12.24 以

降）。詳細については、YASARA ユーザーマニュアル（Help > Show user manual）の Recipes > Dock a ligand to a receptor 

> Useful docking hints 内の「・To run docking on the GPU,～」をご覧ください。 
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2.3 ドッキング結果の確認 

2.3.1 計算終了時の画面 

 

Figure 2.11 ドッキングシミュレーション計算終了画面（結合エネルギーのスコアが高い順に並べられている） 

 

計算が終了すると、ドッキング結果が画面に表示されます。（マクロで実行した場合、このドッキング結果ファイルは

(MacroTarget).sce として自動的に作業ディレクトリに保存されます。一方、『手順 2.2.1』のように Experiment メニューから

実行した場合はファイルが自動的に保存されないため、File > Save as > YASARA Scene を選択し解析結果を含むセッション

全体の情報を Sce 形式で保存する必要があります。）この結果画面では、全てのドッキングポーズの一覧を確認することが

できます。なお、右側の HUD では、リガンドの全ドッキングポーズが結合エネルギーの高い順にリスト化されています。 

 画面上のリガンド 1 分子のいずれかの原子をクリックすると、HUD 左上の BFactor からその結合様式のドッキングスコ

アを確認できるようになっています（単位：kcal/mol、値の大きい方が結合力強）。 

 また、作業ディレクトリには各クラスターの代表構造が Yob 形式で 1 つずつ保存されます（～001.yob、～002.yob…）。 

 

※B Factor（温度因子）は、本来原子の熱振動の大きさを表すパラメータですが、ドッキングの実行時には、ドッキングス

コア（結合エネルギー）を操作画面から確認できるようにするために、一時的に B Factor 値のパラメータにドッキングスコ

アが格納されます。 

 

 

2.3.2 ログファイル（マクロファイル使用時） 

マクロファイルを用いてドッキングを実行すると作業ディレクトリ内にログファイル(.log)が作成され、詳しいドッキン

グ結果を確認することができます。レセプター・リガンド間の結合エネルギー(Binding energy)が強いものから順に並べられ

ており（値の大きい方が結合力強）、その他に解離定数や結合に関与するアミノ酸残基が記載されています。 

また、ドッキング結果のクラスタリングも自動で行われ、その結果が続けて出力されています。 
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Figure 2.12 ドッキング log ファイル 

 

・ログファイルの表に含まれる項目 

Bind.energy[kcal/mol] 
結合エネルギー（Method で指定した AutoDockLGA、または VINA ドッキングスコアの正

負を反転させた値、YASARA では値が大きいほど結合力が強い） 

Dissoc. constant [pM] dissociation constant、Kd：解離定数（値が小さいほど結合力が強い） 

Con.Surf[A^2] contact surface：分子接触面 

Contacting receptor residues 結合に関与するアミノ酸残基 

 

 

2.3.3 マクロファイル「dock_play.mcr」による結果の可視化（マクロファイル使用時） 

GUI 上で結合様式などを確認する場合、「Option」→「Macro&Movie」→「Play macro」を選択してから、「dock_play.mcr」

を指定することで、HUD が Docking Pose Player に切り替わり、ボタン操作でドッキング結果を可視化することができます。

「Proceed to cluster analysis」を選択すると、クラスター分類された結合様式や、レセプター・リガンド間の相互作用（H-Bonds, 

Hydrophobic, Pi/Pi, Cation/Pi）について確認することができます。 

※ドッキング後に YASARA を起動し直した場合は、再度マクロターゲットを指定（計算実行時と同様に指定）してから

「dock_play.mcr」を実行してください。 
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Figure 2.13 「dock_play.mcr」実行画面 

 

Figure 2.14 「dock_play.mcr」クラスター分類や相互作用の表示 

 

 

2.3.4 RMSD 計算 

ドッキング解析で得られた結合ポーズと結晶構造のリガンド座標を比較するため、RMSD 値を計算することができます。 

YASARA GUI を起動しドッキング解析結果である YASARA Scene ファイルをロードします。これには、「File」→「Load」

→「YASARA Scene」として“MacroTarget.sce”ファイルを指定するか GUI 上に該当ファイルをドラッグ＆ドロップします

（本チュートリアルでは 5i3v.sce）。 

続いて、「File」→「Load」→「PDB file from Internet」または「PDB file from local PDB」等から RMSD 計算対象の結晶構

造を読み込みます（PDB file from Internet を実行済みの場合、ローカルディスク上に PDB ファイルが自動保存されている

PDB ID に 5i3v を入力し、OK ボタンをクリックする）。 

次に「Analyze」→「Align」→「Objects with MUSTANG」を選択し、source オブジェクト（動かしたい方、ここでは結晶

構造データ（5i3v））と target オブジェクト（動かしたくない方、ここではレセプター（Receptor））を指定し、アライメント

（構造の重ね合わせ）を行います。 

相互作用の配色 

H-Bonds ：●黄 

Hydrophobic ：●緑 

Pi/Pi ：●赤 

Cation/Pi ：●青 

Ionic ：●マゼンタ 
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Figure 2.15 アライメント画面 

 

続いて、RMSD を計算する際に対象分子の指定をしやすくするため、分子名を重複がないものに変更します（この例で

は、ドッキングリガンドを 1、結晶構造のリガンドを 0 と設定）。 

※操作は任意ですが、そのままでは分子名の重複があるので次の操作が難しくなります。 

 

Figure 2.16 RMSD 計算対象分子（左; 赤色が結晶構造）と分子名の変更例（右） 

 

続いて、「Analyze」→「RMSD of」→「Molecules」を選択し、名前を変更した 2 分子を選んだ後、「Atom name」と「Atom 

alternate location indicator」チェックボックスを有効にし、下部の「Molecule」を選択して OK ボタンをクリックするとコン

ソール上に RMSD の値が出力されます。 

   

Figure 2.17 RMSD 設定画面（左）と出力結果（右） 

 

 

>RMSDMol 0,1,Match=AtomName+AltLoc,Flip=No,Unit=Mol 

Molecule 0 and Molecule 1 have 0.5107 A RMSD 
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3. ドッキング応用（スクリーニング） 

複数のリガンドを用いたドッキングスクリーニングの操作方法を説明します。この項目では、サイクリン依存性キナーゼ

2（CDK2）のタンパク質構造（PDB ID:1h00）を用いて、活性化合物と不活性化合物を含むリガンドライブラリ（計 50 分

子）のドッキングスクリーニングを付属マクロ「dock_runscreening.mcr」を用いて実施します。 

 

※スクリーニングの場合、リガンド構造ファイル名は複数形となる点に注意 

 

3.1 ドッキング準備 

3.1.1 作業ディレクトリの作成と YASARA（GUI）の起動 

手順『2.1.1 作業ディレクトリの作成と YASARA（GUI）の起動』と同様の操作を行い、入出力ファイルの保存先となる

作業ディレクトリの作成・設定を行います。 

※ドッキング基礎で採用したものと異なるファイル名を指定することで、解析結果が混在することはありませんが、前回と

は別のフォルダを作成し使用することをおすすめします。 

 

3.1.2 PDB ダウンロードと構造可視化・確認 

 まず、レセプターとして使用する構造を用意するため、PDB ファイルをダウンロードします。今回は CDK2 と阻害剤の

共結晶構造である「PDB ID:1h00」 を使用するので、メニューから「File」→「Load」→「PDB file from Internet」を選択し、

「1h00」を入力して「OK」をクリックします。ダウンロードが完了すると、画面上にタンパク 3D 構造が表示されます。

（『2.1.2 PDB ダウンロードと構造可視化・確認』を参照してください。） 

 

3.1.3 レセプターファイルの準備（クリーニング・不要分子削除、ドッキングセル設定） 

クリーニング 

 解析のため、「Edit」→「Clean」→「All」を選択して、PDB 構造のクリーニング処理（欠損原子・水素付加、結合次数の

調整など）を行います。 

※クリーニング処理の詳細については、p.3『【Tips】クリーニング処理について』を参照してください。 

 

不要分子の削除 

 次に、タンパク質とリガンド以外の不要な分子を削除します。（次の手順でリガンド分子の周囲にドッキングセルを設定

する際、リガンド分子を利用するので、現時点では削除せずに残しておきます。） 

今回は、不要分子が水分子だけなので、メニューから「Edit」→「Delete」→「Waters」を選択して削除します。 

（もしくは、画面右側 HUD から水分子（赤色の Mol A）を右クリックして「Delete」を実行するなどして水分子を削除し

てもよいです。） 

 

ドッキングセル設定 

結合ポケット付近にドッキング範囲を指定します。画面右側 HUD のリガンド分子（上から 2 番目の Mol A）を右クリッ

クし、「Select」→「newly」を選択することでリガンドを選択状態にします。次に「Simulation」→「Define simulation cell」

を選択し、セルのサイズや形状を設定します（本チュートリアルでは形状を「Cube」、サイズを「7.0 A」に設定）。続いて

「around selected atoms」をクリックすることでリガンド周辺にドッキング範囲(SimCELL)が出現します。 

※SimCELL の設定を省略する場合、タンパク全体を対象としたドッキングが実施されます。詳しくは、ユーザーマニュ

アルの Cell コマンドの説明を参照してください。 

使用するマクロファイル：「dock_runscreening.mcr」 

必要なファイル： ・リガンド構造ファイル 「(Macrotarget）_ligands.(拡張子)」（pdb、yob、sdf 形式） 

   ・レセプター構造ファイル「(Macrotarget）_receptor.(拡張子)」（pdb、yob、sce 形式） 
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Figure 3.1 SimCELL の定義 

リガンド分子の削除 

 画面右側 HUD でリガンド分子（一番下の Mol A）を右クリックし、「Delete」を実行して削除、レセプターと SimCELL の

みを残します。 

 

レセプターファイルの保存 

 レセプターを作業ディレクトリに保存します。ファイル形式は pdb、yob、sce 形式のいずれの形式でも構いませんが、ド

ッキングセル（SimCELL）を設定した場合は、SimCELL の情報も一緒に保存可能な sce 形式を選択する必要があります。 

※SimCELL の設定を省略する場合は、yob または pdb 形式でレセプター構造を保存します（エラーとなるため sce 形式は使

用できません）。この場合、ドッキング計算実行時にレセプター全体を囲むように SimCELL が設定され、タンパク全体を

対象としたドッキングが実施されます。 

本チュートリアルではドッキングセルを設定しているので、sce 形式で保存します。メニューの「File」→「Save as」から

「YASARA Scene」を選択、ファイル名は「(任意の文字列)_receptor(.拡張子)」とします。(任意の文字列)部分は後ほど

MacroTarget として指定し、マクロ実行時に入出力ファイルの共通の接頭辞としてしようされます。そのため、次で準備す

るリガンドファイルと共通の文字列を使用してください（例：1h00_receptor.sce）。 

 

3.1.4 リガンドファイルの準備 

 本チュートリアル用のリガンドライブラリ（zip 形式ファイル）を下記からダウンロードし、ダブルクリックまたは右ク

リック等から展開して得られたファイル「1h00_ligands.sdf」を作業ディレクトリに保存します。 

 

 https://www.affinity-science.com/chronicle/wp-content/uploads/2024/06/1h00_ligands.zip 

 

ファイル名を必要に応じて「(任意の文字列)_ligands(.拡張子)」となるように変更します。(任意の文字列)部分は、必ずレセ

プターファイル名と共通の文字列を使用します（レセプターファイルを「1h00_receptor.sce」としている場合はファイル名

の変更は不要です）。リガンドファイルには、pdb、yob、sdf のいずれかのファイル形式を利用できます。 

※スクリーニング用マクロ（dock_runscreening.mcr）を実行する際に用意するリガンドファイル名は、通常のドッキングと

異なり末尾が複数形の「_ligands」となるので注意します。 

※ドッキングに使用するリガンド構造ファイルは、3D 座標でなければならないので、SMILES 形式や 2D 座標によるファイ

ル形式の場合、予め 3D 化しておく必要があります。 

 

【Note】リガンドライブラリ 

チュートリアル用リガンドライブラリは、活性が報告されている 10 個の化合物（a1~10）に不活性なデコイ分子を 40 個

（d1~40）加えた、計 50 個の分子を用意しました。ファイル形式は、SDF 形式で全て 3D 化されています。 
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【Tips】SMILES や 2D-SDF 形式ファイルの 3D 化について 

 

 YASARA の Infrate コマンドや Optimize コマンド等を利用することで 3D 化することも可能ですが、立体情報を誤っ

て認識する場合があるため、現時点では注意して利用する必要があります。 

化合物の 3D 化は、外部の商用ソフトを利用する他、Open Babel(http://openbabel.org/）や RDKit(https://rdkit.org/)など

のオープンソースソフトウェアを利用することでも可能です（いずれも自己の責任で利用してください）。 

その他、比較的簡単に 3D 化が可能なツールを以下に 2 つ紹介したいと思います。 

1) MolView（https://molview.org/） 

 分子モデリングが可能な無料のウェブアプリケーションです。画面上で化合物を描画、またはデータベース

から検索して化合物を準備し、それを 3D 化してファイルに保存できます。複数の化合物を処理することはでき

ないので、そのような場合は下記の DataWarrior をご覧ください。 

 使い方は、まず、上記のウェブページにアクセスし、2D 描画をするか、検索窓から化合物を検索します（プ

ルダウンから PubChem や RCSP を選択することで、データベースを指定することもできます）。続いて、画面上

部にある「2D to 3D」ボタンをクリックすることで 3D 化ができます。作成したモデルは、「Tools」タブの

EXPORT > MOL file から、MOL ファイルとして保存できます（現行の YASARA ドッキングマクロは、拡張

子.mol に対応していないため、単に拡張子を.mol から.sdf へ変更するか、YASARA でファイルを開き、File > 

Save as から pdb、yob、sdf 形式などに保存し直すなどして使用してください。）。 

2) DataWarrior（https://openmolecules.org/datawarrior/） 

 化学的なデータの可視化と分析が可能なオープンソースプログラムです。SMILES や 2D-sdf などを読み込

み、配座を発生させて 3D 構造を生成することができます。複数の化合物も一括で処理できます。 

利用するには、まず、ダウンロードページ（https://openmolecules.org/datawarrior/download.html）から

DataWarrior をインストールします。起動後、2D-sdf ファイル又は SMILES 列を含むテキストファイル等を File > 

Open…から読み込みます。SMILES を含むファイルはタブ区切りおよびカンマ区切りのテキストファイル（.txt

や.csv など）を利用できます。なお、一番上の行はヘッダーとして扱われるので注意してください。ファイルの

読み込みができたら、メニューから Chemistry > Generate Conformers（配座異性体を生成）を選択することで、

3D 構造を生成することができます（配座生成のアルゴリズムやエネルギー最小化の力場など、様々なオプショ

ンを指定できます。詳細については、ユーザーマニュアル https://openmolecules.org/help/conformers.html をご参照

ください）。生成した構造は、File > Save Special > SD-File…などから保存できます（保存時に表示されるオプシ

ョン"Atom coordinates"にて 3D を選択してください。また、化合物名のカラムがあれば、"Compound name 

column"で指定することで化合物名も一緒に保存できます）。 

DataWarrior の使い方全般については、ユーザーマニュアル（https://openmolecules.org/help/basics.html）をご覧く

ださい。 

 

 

 

 

 

 

 

 

 

 

 

 

MolView 操作画面                  DataWarrior 操作画面 

http://openbabel.org/
https://rdkit.org/
https://molview.org/
https://openmolecules.org/datawarrior/
https://openmolecules.org/datawarrior/download.html
https://openmolecules.org/help/conformers.html
https://openmolecules.org/help/basics.html
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3.2 ドッキング実行 

3.2.1 ターゲット（MacroTarget）設定 

「Options」→「Macro&Movie」→「Set target」で、マクロを適用するために MacroTarget を設定します。 

作業ディレクトリを選択し、レセプターとリガンドのファイル名に使用した共通の (任意の文字列)部分をターゲット名と

して設定します（例：1h00）。例えば、表示されるダイアログから作業ディレクトリを選択後、先ほど作成したリガンドま

たはレセプターファイルのどちらかを選択し、右側の Remove…「from underscore」にチェックを入れてアンダースコア（_）

以下を除外します。もしくは「Filename」に直接(任意の文字列)を入力してもよいです。これにより、 (任意の文字列)が変

数に格納され、マクロ実行時に入出力用のファイル名の共通の接頭辞として処理されます。 

※MacroTarget については、p.6『【Tips】マクロターゲット（MacroTarget）の指定について』を参照してください。 

 

3.2.2 スクリーニング用マクロの実行 

「Options」→「Macro&Movie」→「Play macro」でドッキングを実行します。表示されるダイアログから、マクロファイ

ル dock_runscreening.mcr を選択します。 

※コマンドラインから実行する方法については、前述の「2.2.3 [方法③]マクロファイルを利用する方法（CUI）」を参照して

ください。 

3.3 ドッキング結果の解析 

3.3.1 ログファイル 

マクロを実行してドッキングを開始すると作業ディレクトリ内にログファイル(.log)が作成され、詳しいドッキング結果

を確認することができます。リストにはレセプター・リガンド間の結合エネルギー(Binding energy)が強いものから順に並べ

られています（値の大きい方が結合力強）。ドッキングに使用できなかったリガンド分子（不適切な結合を持つものなど）

がある場合は、最後に結合エネルギー値「-9999」としてリストアップされます。 

なお、dock_runscreening.mcr 内の sortby の値を変更し実行することで、リストの並び順を変更することができます

（ligandnum：リガンド番号、bindnrg：結合エネルギー、effi：リガンド効率）。 

 

・ログファイル中の表に含まれる項目 

Lig. ドッキングの実行順 

Effi[kcal/(mol*Atom)] LE(Ligand efficiency)、リガンド効率：重原子（水素以外の原子）あたりの結合エネルギー 

Bind.energy[kcal/mol] 結合エネルギー（値が大きいほど結合力が強い） 

Dissoc. constant [pM] dissociation constant、Kd：解離定数（値が小さいほど結合力が強い） 

Con.Surf[A^2] contact surface：分子接触面 

Name （リガンドファイル中の）リガンドのオブジェクト名 

Contacting receptor residues 結合に関与するアミノ酸残基 

 

3.3.2 マクロファイル「dock_play.mcr」による解析 

 マクロ「dock_play.mcr」を実行することで、ドッキング結果を可視化して確認することができます。前述の『2.3.2. マク

ロファイル「dock_play.mcr」による可視化』を参照してください。なお、スクリーニングを実行した場合は、「Proceed to cluster 

analysis」を選択すると、各リガンドの代表構造（最も結合エネルギーが高い構造）が順に表示されます。  

 

3.3.3 その他の出力ファイル 

(MacroTarget).sce 受容体、ドッキングセル、全てのリガンドポーズが保存される。 

(MacroTarget)_bestposes.sdf 各リガンドのベストポーズ*が保存される。（リガンドのみ） 

(MacroTarget)_bestposes.pdb 各リガンドのベストポーズ*が保存される。（受容体を含む） 

*ベストポーズ数は、dock_runscreening.mcr マクロ内の'bestposes'パラメータから設定できます。 

 



16 

 

 

 

  

【Tips】ドッキングスクリーニング結果の検証 

 本チュートリアルのスクリーニングの結果（Binding energy 値）を集計し、ドッキングの正答率（Accuracy）を求

めてみました。 

正答率には、ログファイルに記載されている結合エネルギー値を用い、8 kcal/mol 以上を活性あり（正解）と設定し

て次の式を用いて算出しました。 

𝐴𝑐𝑐𝑢𝑟𝑎𝑐𝑦 =
𝑇𝑃 + 𝑇𝑁

𝑇𝑃 + 𝐹𝑃 + 𝐹𝑁 + 𝑇𝑁
 

（TP: True Positive, 真陽性 FP: False Positive, 偽陽性 FN: False Negative, 偽陰性 TN: True Negative, 真陰性） 

 

本チュートリアルで使用したリガンドライブラリは、活性が報告されている化合物が 10 個（a1~10）、不活性なデ

コイ分子が 40 個（d1~40）含まれています。これらの Binding energy 値を基に正誤を集計した結果、正答率（Accuracy）

は 0.48（48%）と算出されました。化合物数が少ないため正確ではありませんが、まずまずの結果が得られました。 

 なお、付属のスクリーニング用マクロ dock_runscreening.mcr では、デフォルトではリガンド 1 分子につき、上位

5 つのドッキングポーズが結果に出力されますが、上記の正答率の算出には最も結合エネルギー値の高いポーズの

みを使用しました。このような場合は、マクロファイルをテキストエディタで開き、「bestposes」設定値（出力ファ

イルに保存されるリガンド 1 分子あたりのポーズ数）を「1」に変更して実行することで、リガンド 1 分子につき

結合エネルギーが最も大きいポーズ 1 つのみが出力されるようになり、集計が容易になります。 
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4. 補足 

4.1 参考情報の紹介 

 YASARA のユーザーマニュアル（Help > Show user manual）の Recipes-Perform complex tasks > Dock a ligand to a receptor に

は、ドッキング関連のヘルプが記載されています。各項目の内容は以下になります。 

 

Recipes-Perform complex tasks > Dock a ligand to a receptor > 

項目 内容 

Global docking of ligands the easy way 基本的なドッキングの方法 

Local docking of ligands the easy way 複合体構造のリガンドの微調整や結合エネルギー予測を行う方法 

Covalent docking of ligands the easy way リガンドが受容体と共有結合を形成する場合の複合体構造予測の方法 

Virtual screening of ligands the easy way 複数のリガンドを同一の受容体にドッキングする方法 

Re-scoring of ligands the easy way ドッキング結果を微調整して再スコアリングする方法 

Playing back the docking results ドッキング結果をインタラクティブに可視化する方法 

Useful docking hints 
ドッキングに関連するヒントが多数記載されています。疑問が生じた

際は、こちらをご参照ください。 

 

 また、Help > Play help movie > 4. Molecular Modeling > 4.5. Drug design のヘルプムービーもドッキング解析の参考になり

ます。 

 

4.2 ドッキング関連の付属マクロファイル 

 YASARA インストールディレクトリのサブディレクトリ mcr 内に格納されています。 

 

ファイル名 機能 

dock_run.mcr 
基本的なドッキング用マクロ。前半の設定部分を編集することでドッキングアルゴリズム、

探索回数、側鎖のフレキシビリティなど変更可能 

dock_runensemble.mcr 
アンサンブルドッキング用マクロ。側鎖の回転により複数のレセプター配座を生成し単一リ

ガンドのドッキングを実施 

dock_runlocal.mcr 
入力複合体構造に対してエネルギー最小化計算を行った後、ドッキングスコアを算出 

dock_runscreening.mcr 
単一レセプターに対して複数リガンド（SDF ファイルまたは連結した YOB ファイル）のドッ

キングを実施 

dock_rescore.mcr 
入力複合体構造に対して各リガンドポーズのエネルギー最小化計算を行い、AutoDock VINA

ローカルサーチを用いてドッキングスコアを再計算 

dock_runcoval.mcr 
共有結合を含む複合体を予測。共有結合が形成される際に除かれるプロトン指定が必要 

dock_play.mcr 
ドッキング結果の可視化・解析用マクロ。結合ポーズの解析、クラスター分類等が可能 

 

以上 


